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Experiment FB-1

Osmoregulation
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Experiment FB-1: Osmoregulation

Background

Sodium is the predominant cation in the extracellular fluid of multicellular animals. The high level of 

sodium ions in seawater results in minimal osmotic stress in many marine organisms. In these animals, 

therefore, minimal ionic and osmotic regulation is required. Furthermore, the large volume of water in 

the ocean ensures minimal fluctuations of the osmotic environment.

Some marine organisms do not spend all of their time in the ocean. Some live in the intertidal region 

where they experience periods of drought, while others may live in tidal pools. In the latter case, the 

relatively small volume of water in the tidal pool may result in fluctuations in the osmotic environment. 

The level of sodium in the pool may increase when the sun evaporates water or decrease when 

freshwater is added through rain or a river. Thus, animals that are trapped in a tidal pool must be able to 

adapt to short-term osmotic stress and survive for about 12 hours until the next tide. 

In this laboratory, you will use a series of dilutions of seawater (with deionized water) to measure the 

affects of solute concentration on the movement of water into or out of a polychaete worm. You will 

place a worm in each solution and then measure its weight change every 10 minutes for one hour. 

Equipment Required

PC or Mac Computer

iWorx data acquisition unit – IXTA

USB cable

Power supply

FT-302 Force Transducer

Ring stand and clamp

Basket and pennies (each weighs about 3 g)

5 x 250 ml beakers

2 x 100 ml graduated cylinders.

Forceps

Marine Worms - www.mainebait.com 

Artificial Seawater (see Appendix)

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial chapter for a picture of the IXTA power supply.
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4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to 

turn on the unit. Confirm that the red power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv4Complete.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu again. Select the Osmoregulation-LS2 settings file from Animal 

Fluid Balance.

5. After a short time, LabScribe will appear on the computer screen as configured by the 

Osmoregulation-LS2 settings.

6. The settings used to configure the LabScribe software and the IXTA unit for this experiment are 

programmed on the Preferences Dialog window which can be viewed by selecting Preferences 

from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

FT-302 Setup

1. Locate the FT-302 force transducer in the IXTA kit (Figure FB-1-S1).

Figure FB-1-S1: The FT-302 force transducer.
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2. Plug the DIN8 connector of the FT-302 into the Channel A5 input of the IXTA(Figure FB-1-

S20).

Figure FB-1-S2: The FT-302 force transducer connected to the IXTA.

3. Attach the transducer to a ring stand using a 90o clamp, so that the transducer is horizontal 

(Figure FB-1-S3).

4. Attach a weight pan to end of the transducer arm.

Figure FB-1-S3: Equipment setup to record weight placed in a pan.

Preparation of Solutions

1. Place or write a label on each 250 ml beaker: 100%, 90%, 80%, 70% and 50%.

Animal Fluid Balance – Osmoregulation - Background                  FB-1-3



Table FB-1-S1:Composition of Solutions for Experiment

Labeled Beaker Artificial Seawater (ml) Deionized Water (ml)

100% 200 0

90% 180 20

80% 160 40

70% 140 60

60% 120 80

2. Make up the seawater solutions (Table FB-1-S1) and place in the appropriately labeled beakers.

Calibration of FT-302 Force Transducer

Aim: To calibrate the force transducer used to measure weight gain or loss of the animal.

Procedure

1. Make sure that the iWorx box is turned on and the FT-302  force transducer is connected to the 

DIN8 input for ten minutes before the calibration is performed.

2. Type No Weight in the Mark box to the right of the Mark button. Click the Record button, and 

press the Enter key to attach a comment to the recording. Record for ten seconds with no weight 

hanging from the arm or hook of the transducer. 

3. Count the number of pennies you have and multiply their number by three (the weight of a 

penny in grams). 

4. Type the weight of the pennies in the Mark box. Place the pennies on the weight pan and press 

the Enter key on the key board, simultaneously. Click the AutoScale button next to the channel 

title area. Record for ten more seconds (Figure FB-1-L1). 

5. Click Stop to halt the recording.

6. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.

7. Remove the pennies from the weight pan.

Animal Fluid Balance – Osmoregulation - Background                  FB-1-4



Figure FB-1-L1: Recording of different known weights used to calibrate the force transducer.

Units Conversion

1. Scroll to the beginning of data when no weight was attached to the force transducer.

2. Use the Display Time icons on the LabScribe toolbar (Figure FB-1-L2) to adjust the Display 

Time of the Main window to show the complete calibration data on the Main window. The 

required data can also be selected by:

• Placing the cursors on either side of data required.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the complete 

calibration data to the width of the Main window.

3. Click the Double Cursor icon so that two blue cursors appear on the Main window. Place one 

cursor on the flat section of data collected when no weight was attached to the FT-302, and the 

second cursor on the flat section of data collected when the pennies were attached to the 

transducer.

Figure FB-1-L2: The LabScribe toolbar.

4. To convert the output of the force transducer from a voltage to the grams of force:

• Click on the arrow next to the title of the Weight channel to open the channel menu. 

• Select Units from the channel menu and Simple from the Units submenu.
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Figure FB-1-L3: The Simple Units Conversion dialogue window with the voltages at the cursors set to 

equal the weight used in calibration.

5. The Simple Units Calibration window will appear (Figure FB-1-L3). On this window:

• Select 2 point calibration from the pull-down menu in the upper-left corner of the 

window. 

• Put a check mark in the box next to Apply units to all blocks. 

• Notice that the voltages from the positions of the cursors are automatically entered into 

the value equations. 

• Enter zero in the corresponding box to the right of the voltage recorded when no weight 

was attached to the transducer. Enter the weight of the pennies in the box to the right of 

the corresponding voltage recorded when the weight of the pennies was hung on the 

hook of the transducer.

• Enter the name of the units, grams, in box below the weights. Click on the OK button in 

the lower right corner of the window to activate the units conversion.

Practice Weighing Technique

Aim: To develop a consistent technique of weighing a worm. 

Procedure

1. Use forceps to remove a worm from seawater. Blot the worm with paper towels to remove 

excess water. 

2. Type No Worm in the Mark box to the right of the Mark button.

3. Click the Record button to record a baseline of ten seconds while only the weight pan is 

attached to the transducer. Continue recording.

4. Type Worm in the Mark box. Place the worm on the weight pan attached to the transducer. 

5. Continue to record for ten seconds after the worm was placed on the weight pan. Click Stop to 

halt the recording. 
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6. Replace the worm in the seawater. 

7. Repeat Steps 1 through 6 for two other worms.

Data Analysis

1. Scroll through the data file to the weighing of the first worm. 

2. Use the Display Time icons to adjust the Display Time of the Main window so that the output of 

the transducer before and after the worm was placed on the weight pan is displayed on the Main 

window. This section of data can also be selected by:

• Placing the cursors on the two levels of the transducer output before and after the worm 

was placed on the weight pan, and

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand or 

contract this section of recording to the width of the Main window.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window.

4. Look at the Function Table that is above the Weight Channel in the Analysis window. The 

mathematical functions, V2-V1 and T2-T1, should appear in this table. The values for these 

parameters are displayed in the table across the top margin of the Weight channel.

5. Maximize the height of the trace on the Weight Channel by clicking on the arrow to the left of 

the channel’s title to open the channel menu. Select Scale from the menu and AutoScale from 

the Scale submenu to increase the height of the data on that channel.

6. Place the cursors on the recording before and after the addition of the worm to the weight pan. 

The value for V2-V1 on the Weight channel is the weight of the worm. 

7. The weight of the worms can be recorded in the on-line notebook of LabScribe by typing their 

names and values directly into the Journal.

8. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the name and value for V2-V1 from the recording to the Journal. To use these functions:

• Place the cursors at the locations used to measure the weight of the worm.

• Transfer the name of the mathematical function used to determine the weight to the 

Journal using the Add Title to Journal function in the Weight Channel pull-down menu.

• Transfer the weight to the Journal using the Add Ch. Data to Journal function in the 

Weight Channel pull-down menu.

9. Repeat Steps 2 through 8 to find the weights of the other two worms weighed in this exercise. 

Record the weights in the Journal and on  Table FB-1-1.

10. Select Save in the File menu.
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Table FB-1-1: Weight of Worms Recorded During Weighing Practice.

Weights (g)

Worm 1 Worm 2 Worm 3

Practice

Osmoregulation

Aim: To measure changes in the weights of five (5) worms placed in different osmotic environments 

using a transducer.

Procedure

1. Use forceps to remove a worm from seawater. Blot the worm with paper towels to remove 

excess water. 

2. Type No Worm in the Mark box to the right of the Mark button.

3. Click the Record button to record a baseline of ten seconds while only the weight pan is 

attached to the transducer. Continue recording.

4. Type Worm 1 in the Mark box. Place the worm on the weight pan attached to the transducer. 

Press the Enter key on the keyboard to mark the recording.

5. Continue to record for ten seconds after the worm was placed on the weight pan. Click Stop to 

halt the recording. Note the time when the worm was weighed. 

6. Record the weight of the worm in the Journal and on Table FB-1-2.

7. Place the worm in the 100% seawater solution. 

8. Repeat Steps 1 through 6 for each of the four other worms used in this exercise. Each worm 

goes into a different solution: 90, 80, 70, or 60% seawater.

9. Every ten minutes, remove each worm from its solution. Blot the worm, weigh it, and return it 

to the same solution. 

10. Record the weight of the worm in the Journal and on Table FB-1-2.

11. Weigh all the worms until you have seven weight values for each worm.

Data Analysis

Graph the weight of each of the five worms in a different solution as a function of time.
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Questions

1. Does the weight of the worm in 100% seawater change? Is the weighing of the worms accurate?

2. Which worm gained weight at the fastest rate? If weight gain indicates water intake, explain the 

results in terms of concentration gradients?

3. Do any of the worms stop gaining weight towards the end of the experiment? How do you 

explain this observation?

Table FB-1-4: Weights of Worms Placed in Solutions of Different Osmotic Strengths Over Time.

Weights (g)

Solutions 100% 90% 80% 70% 60%

Time (min) Worm 1 Worm 2 Worm 3 Worm 4 Worm 5

0

10

20

30

40

50

60
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Table FB-1-1: Recipe for Artificial Seawater

Concentration (mMolar) Salt
Grams/Liter

DI H
2
O

425.0 Sodium Chloride 24.6

9.0 Potassium Chloride 0.67

25.5 ∗Magnesium Sulfate 7H
2
O 6.29

23.0 ∗Magnesium Chloride 6H
2
O 4.66

2.0 Sodium Bicarbonate 0.18

9.3 ∗Calcium Chloride 2H
2
O 1.36

Dissolve all the salts, except CaCl
2
∗2H

2
O, in 750 ml of deionized (DI) H

2
O. Dissolve CaCl

2
∗2H

2
O 

in 200 ml DI H
2
O before adding it to the solution containing the other salts to prevent precipitation of 

calcium carbonate. Adjust the pH of the artificial seawater to 8.0 and add DI H
2
O to bring the final 

volume to 1 Liter.
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